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Preface

This manual describes Campus Manager 3.3 and provides instructions for 
installing and configuring it.

Audience
This document is for anyone who installs, configures, verifies, and uses Campus 
Manager (Campus) software. Network administrators or operators should have 
the following skills:

• Basic Solaris system administrator skills

• Basic network management skills

• Basic Internet browser skill

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font
vii
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Conventions
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Warning This symbol means danger. You are in a situation that could cause bodily injury.

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item in paragraphs Option> Network Preferences

Selecting a menu item in tables Option > Network Preferences

Item Convention
viii
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Product Documentation
Product Documentation

Note Although every effort has been made to validate the accuracy of the information 
in the printed and electronic documentation, you should also review the Campus 
Manager 3.3 documentation on Cisco.com for any updates.

The following product documentation is available: 

• Release Notes for Campus Manager 3.3 on Solaris

• User Guide for Campus Manager

• Context-sensitive online help

Release Notes for Campus Manager 3.3 on Solaris

This document describes the known problems for the Campus Manager 3.3 
software on Solaris.This document is available in the following formats:

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/camp_3x/cmgr_3_3/rel_note/index.htm

• Printed document available bundled with the product.

User Guide for Campus Manager 

This document describes the use and operation of Campus Manager, including 
application descriptions, scenarios, and troubleshooting. This document is 
available in the following formats: 

• PDF on the Campus Manager 3.3 CD-ROM and from the Campus Manager 
3.3 online help.

• On Cisco.com 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/camp_3x/cmgr_3_3/u_guide/index.htm

• Printed document available by order.
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Context-Sensitive Online Help

You can access the help in two ways:

• Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.

Supported Devices Table for Campus Manager 3.3

This document contains information on the devices supported for the Campus 
Manager 3.3 release and device support added with the Incremental Device 
Update (IDU). This document is available on Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/camp_mgr/s
up_dev/cm_3_3.htm

Related Documentation

Note Although every effort has been made to validate the accuracy of the information 
in printed and electronic documentation, you should also review Cisco product 
documentation on Cisco.com for any updates.

The following additional documentation is available:

User Guide for CiscoWorks Common Services

This document describes the use and operation of the CiscoWorks Common 
Services, including application descriptions, scenarios, and troubleshooting. This 
document is available in the following formats: 

• PDF on the CiscoWorks Common Services 2.2 CD-ROM and from the 
CiscoWorks Common Services 2.2 online help.

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
cw2000_d/comser22/usrguide/index.htm

• Printed document available by order.
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Installation and Setup Guide for CiscoWorks Common Services on Solaris

This document describes instructions for installing and configuring the 
CiscoWorks Common Services Application on Solaris. This document is 
available in the following formats: 

• PDF on the Campus Manager 3.3 CD-ROM 

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
cw2000_d/comser22/ig_solcv/index.htm

• Printed document available by order.

Release Notes for CiscoWorks Common Services 2.2 on Solaris

This document describes the known problems for the Campus Manager 3.3 
software on Solaris. This document is available in the following formats:

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
cw2000_d/comser22/rel_note/index.htm

• Printed document available bundled with the product.

Additional Information Online
Incremental Device Update (IDU) contains updated files necessary for the latest 
device support and fixes to known problems that are not available in Campus 
Manager 3.3. If you are a registered user, you can download IDU for Campus 
Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.
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Obtaining Documentation
Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual subscription.

Registered Cisco.com users can order the Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the online Subscription Store:

http://www.cisco.com/go/subscription

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml
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• Registered Cisco.com users can order the Documentation CD-ROM 
(Customer Order Number DOC-CONDOCCD=) through the online 
Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can email your comments to bug-doc@cisco.com.

You can submit your comments by mail by using the response card behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) Website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 
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Obtaining Technical Assistance
Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a 
Cisco product, technology, or solution. Two levels of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The avenue of support 
that you choose depends on the priority of the problem and the conditions stated 
in service contracts, when applicable.

We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network 
functionality is noticeably impaired, but most business operations continue.
xiv
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• Priority level 2 (P2)—Your production network is severely degraded, 
affecting significant aspects of business operations. No workaround is 
available.

• Priority level 1 (P1)—Your production network is down, and a critical impact 
to business operations will occur if service is not restored quickly. No 
workaround is available.

Cisco TAC Website

You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving 
both cost and time. The site provides around-the-clock access to online tools, 
knowledge bases, and software. To access the Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract have 
complete access to the technical support resources on the Cisco TAC website. 
Some services on the Cisco TAC website require a Cisco.com login ID and 
password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/en/US/support/index.html

If you have Internet access, we recommend that you open P3 and P4 cases through 
the Cisco TAC website so that you can describe the situation in your own words 
and attach any necessary files.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
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Before calling, please check with your network operations center to determine the 
level of Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco monthly periodical that provides industry 
professionals with the latest information about the field of networking. You 
can access Packet magazine at this URL:

http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_magaz
ine.html

• iQ Magazine is the Cisco monthly periodical that provides business leaders 
and decision makers with the latest information about the networking 
industry. You can access iQ Magazine at this URL:

http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=tru
e&kbns=1.html
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• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in the design, development, and 
operation of public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training, with current 
offerings in network training listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
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C H A P T E R 1

Prerequisites

This chapter describes the factors that you should consider before installing 
Campus Manager (Campus) on a Solaris system.

This chapter contains:

• Product Overview

• Campus Upgrade Paths

• Server Requirements

• Client Requirements

• Supported Devices
1-1
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Product Overview
Product Overview
Campus, a member of the CiscoWorks family of products, is a suite of web-based 
network management tools that enables administrators to obtain various types of 
graphical views of their network topology and end-user information. Campus 
Manager is based on a client/server architecture that connects multiple web-based 
clients to a server on the network. 

The CiscoWorks Server supplies tools and services to the Campus Manager 
applications, including the Asynchronous Networks Interface (ANI) Server. The 
ANI Server discovers information about network devices and saves it in the ANI 
database for Campus applications, to access. For more information, see User 
Guide for Campus Manager, User Guide for CiscoWorks Server, online help for 
the CiscoWorks Server and online help for the ANI Server.

The Campus Manager applications are:

• Path Analysis—View the actual path that packets take between 
end nodes/ devices on your network.

• User Tracking—Locate and display data about users and hosts in your network.

• Topology Services—Discover, view, and monitor the physical and logical 
services on your network.

• VLAN Port Assignment—View port information, configure VLANs on a 
trunk, and move ports between VLANs on your network.

• Discrepancy Reports—Discover and view physical and logical discrepancies 
in your network.
1-2
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Campus Upgrade Paths
Campus Upgrade Paths
You can upgrade to Campus Manager 3.3 from both Campus Manager 3.1and 
Campus Manager 3.2.

Campus Manager 3.3 requires CiscoWorks Common Services 2.2, which is the 
foundation for the CiscoWorks family of products.

When you install CiscoWorks Common Services, the previous version of Campus 
Manager is removed and only its database is preserved. When you install Campus 
Manager 3.3, certain data from the preserved database is converted to Campus 
Manager 3.3 format. This data includes:

• SNMP community strings

• User Tracking manually entered fields

• Seed devices

• User Tracking preferences

• Path Analysis preferences

• Topology views including Layer 2 View, Unconnected Device View and LAN 
Edge View

You must upgrade to CiscoWorks Common Services 2.2 before installing or 
upgrading to Campus 3.3.

Caution Uninstalling Campus deletes the ANI database.
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Server Requirements
Server Requirements
This section describes the system requirements and recommendations for 
CiscoWorks Common Services 2.2 and Campus Manager 3.3.

The minimum system requirements for CiscoWorks Common Services 2.2 and 
Campus Manager 3.3 are shown in Table 1-1.

Table 1-1 Server System Requirements Summary 

Requirement Type Minimum Requirement1

1. If other applications are installed, or the number of devices on your network exceeds 500, the requirements might be greater.

System hardware • Sparc Ultra 10

• CD-ROM drive

Memory (RAM) 512 MB 

Available drive space2 • 4 GB on the partition on which you install the product 
(the default is /opt)

• Swap space equal to double the amount of memory 
(RAM). For example, if your system has 512 MB of 
RAM, you need 1024 MB of swap space.

/tmp directory Must be on a swap partition.

System software Solaris 2.7 or 2.8.3

Campus Manager supports US-English and Japanese 
versions of Solaris Operating Systems. It does not support 
any other language version. Set the default locale to 
US-English for US-English version and Japanese for 
Japanese version.

Additional software You must install CiscoWorks Common Services 2.2 before 
installing Campus. If you installed a version of CiscoWorks 
Common Services earlier than 2.2, upgrade to 2.2 before 
installing Campus Manager 3.3. See Installation and Setup 
Guide for CiscoWorks Common Services on Solaris.

Netscape Navigator 4.76 (if you are using the desktop on the 
server system).

Note For Solaris, use Netscape Navigator downloaded 
only from the Sun site.
1-4
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Server Requirements
Checking Required Disk Space
To verify the amount of available disk space in each of the specified partitions and 
directories, enter:

# df -k directory

where directory is the partition or directory for which you want to check the 
available disk space.

Maximum Recommended Load
The maximum recommended load on servers configured with the minimum server 
requirements shown in Table 1-1 is 500 Cisco devices and one client at a time.

If other network management applications are installed on your server, additional 
resources might be required.

Server Recommendations
If your network has more than 500 Cisco devices, the following minimum 
requirements are recommended:

• A Sparc Ultra 60 processor

• 512 Mb of memory (RAM)

• 1 GB of swap space

2. For information about verifying disk space, see the “Checking Required Disk Space” section on page 1-5.

3. Patch 106292-05 must not be installed.
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Client Requirements
Client Requirements
The minimum client system requirements for CiscoWorks Common Services 2.2 
and Campus Manager 3.3 are shown in Table 1-2. The maximum recommended 
load on clients configured with the minimum requirements shown in Table 1-2 is 
2000 Cisco devices.

Note Before you can access Campus from a client system, you must configure the 
system properly. For information about configuring clients, see Installation and 
Setup Guide for CiscoWorks Common Services on Solaris.

Table 1-2 Client System Requirements Summary

 Requirement Type Minimum Requirement

System Software and 
Hardware

• Client system:

– IBM PC-compatible computer with 300 MHz Intel Pentium processor 
running Windows 2000 (Professional or Server), or Windows XP with 
Service Pack 1. 

– Solaris SPARCstation or Sun Ultra 10 running Solaris 2.7 or 2.8. 

– Color monitor with video card set to 24 bits color depth.
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Supported Devices
For information about supported devices, access the Supported Devices table at 
the following location: 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/camp_mgr/
sup_dev/cm_3_3.htm

Memory (RAM) 256MB

Browser One of the following browsers:

On Windows 2000 and Windows XP clients:

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000) or Internet 
Explorer 6.0 with Service Pack 1 (version 6.0.2800.1106),

• Java Virtual Machine (JVM) 5.0.0.3802 and above, and Java plug-in 
version 1.3.1.

To verify the JVM, select View > Java Console from Internet Explorer 
and Tools > Server > Java Console from Netscape Navigator.

• Netscape Navigator 4.78 and 4.79 for Windows.

On Solaris clients:

• Netscape Navigator 4.76 for Solaris 2.7 and 2.8.

Note For Solaris, use Netscape Navigator downloaded only from the Sun 
site.

Table 1-2 Client System Requirements Summary (continued)

 Requirement Type Minimum Requirement
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C H A P T E R 2

Installing Campus Manager 

This chapter describes how to install, upgrade, uninstall, and reinstall Campus 
Manager (Campus). You must install CiscoWorks Common Services before you 
can install Campus Manager. See Installation and Setup Guide for CiscoWorks 
Common Services on Solaris.

This chapter contains:

• Installation Overview

• Performing a New Installation

• Performing an Upgrade Installation

• Importing Data After Installation

• Uninstalling Campus Manager
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Installation Overview
Table 2-1 is an overview of the Campus Manager installation tasks. It contains 
references to more detailed information about each task.

Table 2-1 Installing Campus Manager Overview

Task Steps References

1. Prepare to 
install Campus 
Manager.

Verify that server requirements 
are met.

“Server Requirements” section on page 1-4

2. Install 
Campus.

a. Mount the Campus Manager 
CD-ROM.

Appendix B, “Mounting and Unmounting the 
CD-ROM”

b. Run the installation 
program.

“Performing a New Installation” section on 
page 2-3

or 

“Performing an Upgrade Installation” section 
on page 2-6

3. Verify and 
troubleshoot 
the installation.

a. Verify that correct files and 
directories are installed.

 “Understanding Installation Error Messages” 
section on page A-3 

b. Analyze installation error 
messages.

“Understanding Installation Error Messages” 
section on page A-3

4. Set up Campus 
Manager.

Prepare the system for Campus 
applications and set up the 
applications.

Chapter 3, “Preparing to Use Campus 
Manager” 
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Performing a New Installation
This section describes a new Campus Manager installation. If you are upgrading 
from Campus Manager 3.1 or 3.2, see the “Performing an Upgrade Installation” 
section on page 2-6.

Installation Notes
You must install CiscoWorks Common Services 2.2 before installing Campus. See 
Installation and Setup Guide for CiscoWorks Common Services on Solaris.

Campus Manager is installed in the directory where you installed CiscoWorks 
Common Services 2.2.

You can press Ctrl-C at any time to end the installation. However, any changes to 
your system (for example, installation of new files or changes to system files) will 
not be undone.

The Campus Manager 3.3 installer will automatically update Campus 3.2 and 3.1 
program files and migrate user-entered data related to Campus. The Campus 3.3 
installer will also automatically re-apply some device updates previously released 
on Cisco's download site as Incremental Device Updates (IDU). IDU 1.0 and IDU 
2.0 have been incorporated in Campus 3.3. If you have installed IDU 3.0 or higher 
for Campus 3.2, you will need to re-apply that IDU after the Campus 3.3 
installation is complete.
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Running the Installation Program—New Installation
To install Campus Manager:

Step 1 As root, mount the Campus Manager CD-ROM, using either of the following 
methods:

• Mount the CD-ROM on the Campus Manager server system.

• Mount the CD-ROM on a remote Solaris system, then access the CD-ROM 
from the Campus Manager server system.

See Appendix B, “Mounting and Unmounting the CD-ROM” for mounting 
instructions.

Step 2 Run the installation program.

For a local installation, enter:

# cd /cdrom/cdrom0/
# ./setup.sh 

For a remote installation, enter:

# cd remotedir
# ./setup.sh

where remotedir is the remote location where the CD-ROM is mounted.
A message appears:

Press Enter to read/browse the following license agreement:

Step 3 Press Enter to read the license agreement. The following message appears at the 
end of the license agreement:

You must accept this License agreement for the installation to 
proceed. If you enter N/n, the installation will exit.
Do you accept all the terms of the preceding License agreement? (y/n) 
[y]

Step 4 Enter y to accept the license and proceed with the installation or Enter n to deny 
and quit installation.

Note Campus is installed in the same location as CiscoWorks Common Services. The 
default is /opt/CSCOpx.
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The installation program checks for compatible patches, dependencies, and disk 
space.

Step 5 Answer any questions that result from the checks.

The installation program prompts you to change the default password for the ANI 
database. 

Step 6 Enter your ANI password. 

The installation program displays many messages about the various packages 
being installed and the services being started. The packages include application 
software and device adapter packages for all devices that can be managed with 
Campus applications. The following message appears:

To ensure that you retain the latest device support and bug 
fixes, please install the latest Incremental Device Update (IDU) 
for Campus Manager 3.3. You can download the latest IDU from
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.

Please refer to the Installation and Setup Guide for details.

Note For more information about IDU, see “FAQs about IDU” section on page A-7.

The installation completes, installing Campus in the same location as CiscoWorks 
Common Services 2.2 (/opt/CSCOpx by default). The CiscoWorks Server starts

If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. For information about troubleshooting, see 
Appendix A, “Troubleshooting the Installation.”

After the installation completes, do either of the following:

• If you have data from the earlier version of Campus Manager (3.1 or 3.2) to 
import into Campus Manager 3.3, see the “Importing Data After Installation” 
section on page 2-10.

• If you do not have data to import, continue to Chapter 3, “Preparing to Use 
Campus Manager.”

For more information about the ANI database, see the “Understanding the Data 
Conversion” section on page 2-11.
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Performing an Upgrade Installation
You can upgrade to Campus Manager 3.3 from Campus Manager 3.2 and Campus 
Manager 3.1. For versions earlier than 3.1, upgrade to Campus Manager 3.1 
before upgrading to Campus Manager 3.3.

Campus Manger 3.3 requires CiscoWorks Common Services 2.2, which is the 
foundation for the CiscoWorks Family of Products. 

When you install CiscoWorks Common Services, the previous version of Campus 
Manager is removed and its database is preserved. When you install Campus 
Manager 3.3, certain data from the previous installation is preserved. 

This data includes:

• SNMP community strings

• User Tracking manually entered data fields

• Seed devices

• User preferences

• Topology views including Layer 2 View, Unconnected Device View and LAN 
Edge View

You must upgrade to CiscoWorks Common Services 2.2 before installing or 
upgrading to Campus 3.3.

Caution Uninstalling Campus deletes the ANI database.

For more information about the ANI database, see the “Understanding the Data 
Conversion” section on page 2-11.

Installation Notes
You must install CiscoWorks Common Services 2.2 before installing Campus. See 
Installation and Setup Guide for CiscoWorks Common Services on Solaris.

Campus Manager is installed in the directory where you installed CiscoWorks 
Common Services 2.2. 
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You can press Ctrl-C at any time to end the installation. However, any changes to 
your system (for example, installation of new files or changes to system files) will 
not be undone.

The Campus Manager 3.3 installer will automatically update Campus 3.2 and 3.1 
program files and migrate user-entered data related to Campus. The Campus 3.3 
installer will also automatically re-apply some device updates previously released 
on Cisco's download site as Incremental Device Updates (IDU). IDU 1.0 and IDU 
2.0 have been incorporated in Campus 3.3. If you have installed IDU 3.0 or higher 
for Campus 3.2, you will need to re-apply that IDU after the Campus 3.3 
installation is complete.

Running the Installation Program—Upgrade or Reinstallation
Use this installation procedure if you allowed the CiscoWorks Common Services 
installation program to save the previous data and remove the previous software. 

If you installed CiscoWorks Common Services on a clean system, follow the 
procedure for a new installation in the “Performing a New Installation” section on 
page 2-3. 

After installing Campus Manager, you can manually import your existing 
database to the system on which CiscoWorks is installed if it was not 
automatically imported during installation. See the “Importing Data After 
Installation” section on page 2-10.

To run the installation program for an upgrade:

Step 1 As root, mount the Campus Manager CD-ROM, using either of the following 
methods:

• Mount the CD-ROM on the CiscoWorks server system.

• Mount the CD-ROM on a remote Solaris system, then access the CD-ROM 
from the CiscoWorks server system.

See Appendix B, “Mounting and Unmounting the CD-ROM,” for detailed 
mounting instructions.
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Step 2 Run the installation program.

For a local installation, enter:

# cd /cdrom/cdrom0/
# ./setup.sh 

For a remote installation, enter:

# cd remotedir
# ./setup.sh

where remotedir is the remote location where the CD-ROM is mounted.

A message appears:

Press Enter to read/browse the following license agreement:

Step 3 Press Enter to read the license agreement. The following message appears at the 
end of the license agreement:

You must accept this License agreement for the installation to 
proceed. If you enter N/n, the installation will exit.
Do you accept all the terms of the preceding License agreement? (y/n) 
[y]

Enter y to accept the license and proceed with the installation or Enter n to deny 
and quit installation.

If you are reinstalling Campus Manager continue to Step 4. If you are upgrading 
skip to Step 6.

Note Campus is installed in the same location as CiscoWorks Common 
Services. The default is /opt/CSCOpx.

Step 4 A prompt appears:

Campus Manager 3.3 has been detected on your system. If you are running 

an evaluation version of Campus Manager 3.3 and you choose to reinstall 

the product, you will automatically upgrade to a licensed version. Are 

you sure you want to reinstall this software and any required 

patches.(y/n)? [n]

Step 5 Enter y to continue to install or n to cancel.

The installation program checks on your system for compatible patches, 
dependencies, disk space, memory (RAM), and swap space.
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Step 6 Answer any questions that result from the pre-installation checks.

The installation program prompts you to change the default password for the ANI 
database. 

Step 7 Enter your ANI password. 

The installation program displays many messages about the various packages 
being installed and the services being started. The packages include application 
software and device adapter packages. The packages for all devices that can be 
managed with Campus applications are installed. The database is converted.

The following message appears:

To ensure that you retain the latest device support and bug 
fixes, please install the latest Incremental Device Update (IDU) 
for Campus Manager 3.3. You can download the latest IDU from
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus.

Please refer to the Installation and Setup Guide for details.

Note For more information about IDU, see “FAQs about IDU” section on page A-7.

The installation completes. The CiscoWorks Server is running.

If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. For troubleshooting information, see Appendix A, 
“Troubleshooting the Installation.”

After the installation finishes, choose one of the following:

• If you installed Campus on a different system and have data to import, you 
can import the database remotely. See the “Importing Data After Installation” 
section on page 2-10 for more information.

• If your data is already converted or you do not want to import the old data, 
continue to Chapter 3, “Preparing to Use Campus Manager.”

After Campus is installed, Topology Services allows you to either convert the 
saved views in the new Campus Manager 3.3 format or directly use the default 
views generated by Campus Manager 3.3. See the “Upgrading Saved Views From 
Topology Services” section for more information.
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Upgrading Saved Views From Topology Services
Use the following procedure to upgrade saved topology views to the new Campus 
Manager 3.3 format. 

If you do not want to upgrade to the new format but want to use the default views 
generated by the previous version of Campus Manager (3.1or 3.2), skip the 
following procedure and select Layer 2 View, LAN Edge View, or Unconnected 
Devices View from the side panel in Topology Services.

Step 1 Start Topology Services from the desktop.

Step 2 Select File > Upgrade View Layouts.

Step 3 Select the view you want to upgrade.

Step 4 Click Upgrade to upgrade the selected view.

Topology Services upgrades the selected view to the Campus Manager 3.3 format. 

Step 5 To display this view, select the corresponding view from the side panel in 
Topology Services. 

Note The upgraded view might not be formatted in exactly the same manner as 
the previous version of the view. This is because of the new features in 
Campus Manager 3.3.

Importing Data After Installation
This section describes how to manually import data from previous versions of 
Campus. You might need to import data manually if you performed a new 
installation of Campus but have data from previous versions of the software on a 
different system.
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Understanding the Data Conversion
Data must be converted from Campus Manager 3.1 and Campus Manger 3.2 
formats to Campus Manager 3.3 format. 

Converting Campus Data

Campus Manager accesses the ANI database for critical network information. The 
database from previous versions of Campus Manager (3.1or 3.2) is saved, and data 
from the database can be converted to Campus Manager 3.3 format for immediate 
use.

The CiscoWorks Common Services installation, which is required for the Campus 
Manager installation, automatically saves your old database. When you install 
Campus Manager, the saved database is imported into the new file, ani.db. After 
you import your database into Campus Manager 3.3, the old ANI database, called 
ani.db, remains in the directory you indicated during the CiscoWorks Common 
Services install until you remove it.

For more information about the ANI database, see the ANI online help or User 
Guide for CiscoWorks Server.

Converting Campus 3.1 or Campus 3.2 Data

The community strings are upgraded from the old anisnmp.conf file to the updated 
anisnmp.conf file. Some critical properties from the old ANIServer.properties file 
are updated in the new ANIServer.properties file.

The User Tracking data is extracted from the old ani.db file and saved as 
rigel_ut.txt. This data is found and processed during the first User Tracking 
discovery.

Topology Services saves topology views from previous versions of Campus 
Manager (3.1or 3.2). The following views are saved:

• Layer 2 View

• Unconnected Device View

• LAN Edge View
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After Campus is installed, Topology Services allows you to either convert the 
saved views into the new Campus Manager 3.3 format or directly use the default 
views generated by Campus Manager 3.3.

Importing Data Manually from Campus Manager 3.1 or 3.2
Follow this procedure to remotely import saved data from Campus Manager 3.1 
or 3.2.

Step 1 Stop the daemon manager on the local machine on which the previous version of 
Campus Manager is installed. 

For more information on stopping the daemon manager, refer to Installation and 
Setup Guide for CiscoWorks Common Services on Solaris.

Step 2 Mount CiscoWorks Common Services 2.2, on the local machine.

Step 3 To save CiscoWorks data, enter:

# cd /cdrom/cdrom0/
#./export_cdone.pl

A prompt appears asking you to enter the location where you want to export 
CiscoWorks Common Services data.The default location is /opt/CSCOpx/rigel or 
where Campus Manager 3.1 or 3.2 has been installed.

Step 4 Mount Campus Manager 3.3 on the local system.

Step 5 To save Campus data, enter:

# cd /cdrom/cdrom0/
# ./export_cm.pl

A prompt appears asking you to enter the location where you want to export 
Campus data.The default location is /opt/CSCOpx/rigel or where Campus 
Manager 3.1 or 3.2 has been installed.

Note You must export Campus data to the location where CiscoWorks Common 
Services data has been exported.
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Step 6 Copy all subdirectories except the scripts directory from the location in the local 
machine to which you have exported the data to $NMSROOT/rigel on the remote 
system.

Step 7 Start the daemon manager on the local machine. 

For more information, see Installation and Setup Guide for CiscoWorks Common 
Services on Solaris.

Step 8 Stop the daemon manager on the remote machine. 

For more information on stopping the daemon manager, see Installation and Setup 
Guide for CiscoWorks Common Services on Solaris.

Step 9 To copy CiscoWorks data to corresponding CiscoWorks Common Services 
directories on the remote machine, enter:

# cd /$NMSROOT/rigel/scripts
# ./import_cdone.pl

A prompt appears:

Importing will cause all the export data files to be overwritten.
Are you sure you want to import CiscoWorks data (y/n)? [n]

Step 10 Enter y to import or n to cancel.

Step 11 To copy Campus data to corresponding Campus Manager 3.3 directories, enter:

# cd /$NMSROOT/rigel/scripts
# ./import_cm.pl

A prompt appears:

Importing will cause all the files to be overwritten. Are you sure you 
want to import Campus data (y/n)? [n]

Step 12 Enter y to import or n to cancel.

Step 13 Start the daemon manager on the remote machine. 

Step 14 For more information see Installation and Setup Guide for CiscoWorks Common 
Services on Solaris.

After Campus is installed, Topology Services allows you to either convert the 
saved views into the new Campus Manager 3.3 format or directly use the default 
views generated by Campus Manager 3.3. See the “Upgrading Saved Views From 
Topology Services” section for more information.
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Uninstalling Campus Manager 
The uninstallation program removes Campus files and settings. The uninstall 
option enables you to remove only Campus or remove CiscoWorks Common 
Services as well.

Caution You must use the Campus Manager uninstallation program to remove the product. 
If you attempt to remove Campus Manager or its components manually, you could 
damage your system.

Caution Uninstalling Campus Manager deletes the ANI database. To upgrade and convert 
the database, see the “Performing an Upgrade Installation” section on page 2-6.

To remove Campus Manager or other major components:

Step 1 Enter the following commands as root to start the uninstall program:

# cd /
# /opt/CSCOpx/bin/uninstall.sh

where /opt/CSCOpx is the default installation directory. If you specified a 
different directory when you installed Device Manager, substitute the name of the 
directory.

A prompt similar to the following appears:

1) Cisco View
2) Integration Utility
3) CiscoWorks Common Services
4) Campus Manager
5) All of the above
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Step 2 Select one or more of the items using its number separated by comma or enter q 
to quit [q]

• To remove Campus Manager only, enter the number that corresponds to it (in 
this case, 4). 

• To remove Campus Manager, CiscoWorks Common Services, Cisco View 
and Integration Utility enter the number that corresponds to all of the above 
(in this case, 5).

A prompt appears, where the default selection is indicated in brackets:

Are you sure you want to uninstall: program name (y/n)? [n]

where program name is the name of the choice you entered in the last question. 

Step 3 Enter y to continue to uninstall or n to cancel.

A prompt appears that lists the packages that the uninstallation is about to delete:

Delete the CiscoWorks packages? (y/n)? [y]

Step 4 Enter y to continue to uninstall or n to cancel.

Other prompts might appear. Answer them appropriately.

The installation program displays a series of messages. Ignore any additional 
messages that ask if you want to remove packages. You cannot answer these 
questions.

When you remove Campus, the uninstall script removes changes made to the 
/etc/services file. The /etc directory still contains all system file changes. The 
uninstall messages are written to the /var/tmp/ciscouninstall.log file.

After the uninstallation script successfully completes, the following message 
appears:

All files were deleted successfully.

Step 5 Check /etc/syslog.conf for syslog changes. See Appendix A, “Troubleshooting 
the Installation” for more information.

To reinstall Campus Manager, follow the instructions in the “Performing an 
Upgrade Installation” section on page 2-6.
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Preparing to Use Campus Manager

This chapter describes the various administrator and application setup tasks that 
you must perform after installing Campus Manager (Campus). 

This chapter contains:

• Overview of Campus Setup Tasks

• Accessing the CiscoWorks Server

• Performing Administrator Tasks

• Setting Up Campus Manager Applications

• Logging Out as Administrator
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Overview of Campus Setup Tasks
Table 3-1 provides an overview of the Campus Manager setup tasks and 
references to more detailed information about each task. 

Table 3-1 Overview of Campus Setup Tasks

Task Steps References

1. Access the 
server.

Access the CiscoWorks Server. “Accessing the CiscoWorks Server” 
section on page 3-3

2. Perform 
administrator 
setup tasks.

a. Log in to the server as administrator. “Logging In as Administrator” section 
on page 3-4

b. Back up the ANI database. “Backing Up the ANI Database” 
section on page 3-4

3. Set up 
applications.

Launch and configure applications. “Setting Up Campus Manager 
Applications” section on page 3-5 

4. Log out. Log out of the server. “Logging Out as Administrator” 
section on page 3-12
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Accessing the CiscoWorks Server

Note You must set up the client before using Campus. See Installation and Setup Guide 
for CiscoWorks Common Services on Solaris for configuring browser and client 
systems.

To access Campus Manager, enter the URL of the CiscoWorks Server in your web 
browser:

http://server_name:1741
https://server_name:1742 (for SSL mode)

where server_name is the name of the CiscoWorks Server. If you were prompted 
to supply a port number for the CiscoWorks Server during the installation, use that 
port number in the URL. The default port number is 1741 (1742 if SSL is 
enabled).

If you cannot access the CiscoWorks Server or the desktop is not displayed 
correctly, refer to Appendix A, “Troubleshooting the Installation.” In addition, 
see the troubleshooting chapter in User Guide for Campus Manager. 

After you access the CiscoWorks Server, see the “Performing Administrator 
Tasks” section on page 3-4.
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Performing Administrator Tasks
After accessing the CiscoWorks Server, you must log in as the administrator and 
set up the server for other users.

Logging In as Administrator
To log in as administrator:

Step 1 Enter the system administrator username and password in the Login Manager 
dialog box.

Step 2 Click Connect.

The Login Manager dialog box is replaced by the navigation tree.

To log out the CiscoWorks Server, see the “Logging Out as Administrator” section 
on page 3-12 for information.

After you log in as the administrator, continue to the “Backing Up the ANI 
Database” section on page 3-4.

Backing Up the ANI Database
You should back up the ANI database immediately after a new or upgrade 
installation. This creates a backup compatible with the previous version of 
Campus Manager in case you need to restore your database. This also prevents 
you from overwriting your database by restoring a backup from the previous 
version. See the ANI Server online help or Getting Started With the CiscoWorks 
Server for more information.

After you have performed the necessary administrator tasks, continue to the 
“Setting Up Campus Manager Applications” section on page 3-5.
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Setting Up Campus Manager Applications
This section describes the tasks that you must perform to set up the Campus 
Manager applications. See the online help for individual applications for 
troubleshooting information.

This section contains:

• Setting Up Your Network

• Configuring the ANI Server

• Setting Up Topology Services

• Setting Up User Tracking

• Setting Up Path Analysis

• Setting Up VLAN Port Assignment

• Setting Up Discrepancy Reports

Note Many tasks require the administrator login.
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Setting Up Your Network
To ensure that the ANI Server successfully discovers the devices in your network, 
you must set up your network correctly. Table 3-2 lists the required tasks for each 
application, marked by a check mark ( ). 

See the ANI Server online help, User Guide for Campus Manager and User Guide 
for CiscoWorks Common Services for more information. 

Table 3-2 Network Setup Tasks

Topology 
Services 

User 
Tracking 

Path 
Analysis 

VLAN Port 
Assignment

Discrepancy 
Reports Network Setup Requirement

¸ ¸ ¸ ¸ ¸ Connect to seed device.

¸ ¸ ¸ ¸ ¸ Enable Simple Network Management 
Protocol (SNMP).

¸ ¸ ¸ ¸ ¸ Enable Cisco Discovery Protocol 
(CDP).

¸ ¸ ¸ Enable Call Detail Record (CDR).

¸ ¸ ¸ ¸ ¸ Set a unique sysName variable on 
devices.

¸ ¸ ¸ ¸ ¸ Enable Integrated Local 
Management Interface (ILMI) on 
ATM devices.

¸ ¸ ¸ ¸ ¸ Configure DNS.

¸ ¸ ¸ ¸ ¸ Configure VLAN Trunk Protocol 
(VTP).

¸ ¸ ¸ ¸ ¸ Configure VLAN trunks on Fast 
Ethernet and Gigabit Ethernet.

¸ ¸ ¸ ¸ ¸ Create the default configuration 
server for ATM LAN Emulation 
(LANE).

¸ ¸ ¸ Enable source routing.
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Setting Up Campus Manager Applications
After you set up your network, continue to the “Configuring the ANI Server” 
section on page 3-7. 

Configuring the ANI Server
Before starting a Campus Manager application, the ANI Server must be running 
and properly set up. You must verify that the correct community strings and a seed 
device are specified. In SNMP settings, there is a check box option to encrypt and 
store the community strings in the server. 

For security reasons we recommend that you enable this option. If you do not 
enable this option the community strings will be stored as plain text. You can also 
check to see that the ANI Server is running. See the ANI Server online help and 
User Guide for Campus Manager for assistance in performing these tasks.

After you configure the ANI Server, see the “Setting Up Topology Services” 
section on page 3-7.

Setting Up Topology Services
To set up Topology Services:

Step 1 Add a seed device to the ANI Server. 

For more information, see the Topology Services online help or the ANI online 
help.

Step 2 Make sure the ANI Server is running. 

See the ANI Server online help for more information.

Step 3 Select Campus Manager> Topology Services to start the application.
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Configuring Network Discrepancies

You can configure the network discrepancies that you would like reported by 
selecting and deselecting the listed discrepancies. Select Campus Manager > 
Administration>Network Discrepancies. See User Guide for Campus Manager 
for more information.

Verifying Topology Services

To verify that Topology Services is working properly:

Step 1 Verify that all devices and interfaces are discovered. 

Properly discovered devices and interfaces appear in green in the Topology 
Services window.

Step 2 Verify that devices displayed in red are reachable and have correct community 
strings.

Step 3 Verify that all VLANs and ELANs are discovered and that their port assignments 
are correct.

For more information, see the Topology Services online help.

Setting Up User Tracking
To set up User Tracking:

Step 1 Start User Tracking. 

Step 2 Confirm that the Ping Sweeps option is enabled. 

If you enable User and Host Acquisition, perform the tasks outlined in the 
“Supporting User Name Collection” section on page 3-9.

For more information, see the User Tracking online help.
3-8
Installation and Setup Guide for Campus Manager on Solaris

78-15049-01



 

Chapter 3      Preparing to Use Campus Manager
Setting Up Campus Manager Applications
Supporting User Name Collection

To have the ANI Server automatically retrieve user names for User Tracking, you 
must enable user and host acquisition and install appropriate scripts. See the ANI 
Server online help for more information.

Verifying User Tracking

To verify that User Tracking is working properly, discover with a ping sweep to 
verify that all end-user stations are discovered.

Setting Up Path Analysis
To set up Path Analysis:

Step 1 Install and configure a DNS server on your network. 

A DNS server is required for Campus Manager. For devices with multiple IP 
addresses, there should be a single DNS entry that includes all IP addresses.

Step 2 Specify correct read community strings on all devices. 

Step 3 Specify correct write community strings for multi-layer switching shortcut path 
determination on Catalyst 5000 devices.

Step 4 Edit the VLAN/ELAN Mapping Table, which provides mapping of VLANs and 
ELANs to subnets. 

These mappings are auto-discovered based on information discovered by 
Topology Services and User Tracking. 

In some cases, the information might be incomplete. In these cases, you can edit 
a VLAN/ELAN mapping table to supplement the Topology Services and User 
Tracking information. If subnet mappings are not correct, Layer 2 traces on those 
subnets might fail.

Step 5 Enable Cisco Discovery Protocol (CDP) on all Cisco devices. 

If CDP is not enabled, these devices will not appear on Layer 2 path traces.
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Step 6 Enable source routing on your network. 

This is required if you plan to run path traces outside of the domain known to 
Topology Services.

For more information, see the Path Analysis online help.

Verifying Path Analysis

To verify that Path Analysis is working properly:

Step 1 Run Action >Discover All.

Step 2 Start Topology Services and make sure that all devices, interfaces, and links are 
discovered properly. 

Properly discovered devices appear in green in the Topology Services window. 

Step 3 Verify that all VLANs and ELANs are discovered with correct port assignments.

Step 4 Start User Tracking and run Discovery with a ping sweep to verify that all 
end-user stations are discovered.

Step 5 Run nslookup on several known devices in the command shell. 

Step 6 Verify that DNS lookup works and takes one second or less.

Step 7 Verify the Subnet Mapping table entries. 

Each VLAN and ELAN entry should have any corresponding subnets listed. Any 
subnets that do not correspond to a VLAN or ELAN should be in a Subnet row.

Step 8 Run a few traces between endpoints known to User Tracking or Topology Services 
and verify that the trace completed successfully.

For troubleshooting information, see the Path Analysis online help.

Setting Up VLAN Port Assignment
To set up VLAN Port Assignment, start VLAN Port Assignment. 

For more information, see the VLAN Port Assignment online help.
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Displaying Topology Views and Attribute Summaries

To highlight devices, VLANs in a VTP domain, or a VTP domain map, or to 
display attribute summaries for devices, Topology Services must be running. See 
the VLAN Port Assignment online help for more information.

Verifying VLAN Port Assignment

To verify that VLAN Port Assignment is working properly:

Step 1 Check the status bar to verify that the ANI Server is running properly.

Step 2 Perform a Port Summary for a VTP Domain. 

The table should be populated with that domain’s port information.

Step 3 Select a port, preferably unconnected, and move it to a different VLAN. 

The port information should be updated.

See the VLAN Port Assignment online help for more information.

Setting Up Discrepancy Reports
To set up Discrepancy Reports:

Step 1 Select the Discrepancy Reports folder from the desktop.

Step 2 Start Physical Discrepancy Reports or Logical Discrepancy Reports.

For more information, see the Discrepancy Reports online help.

Verifying Discrepancy Reports

To verify that Discrepancy Reports is working properly, check the status bar to 
verify that the ANI Server is running properly.
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Logging Out as Administrator
Logging Out as Administrator
To end your administrator tasks, you must log out of Campus Manager. 

Step 1 Close all secondary browser windows. You should have only one browser window 
opened displaying the Campus Manager interface.

Step 2 Click Logout. 

The Login Manager dialog box replaces the navigation tree.
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Troubleshooting the Installation

This appendix provides troubleshooting information for Campus Manager 
(Campus) installation and setup.

This appendix contains:

• Logging In After Upgrading

• Understanding Installation Error Messages

• Failing to Delete a Package During Uninstallation

• Accessing the CiscoWorks Server

• FAQs about IDU
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Logging In After Upgrading
If the Login Manager dialog box on the CiscoWorks desktop does not appear 
correctly when you attempt to log in for the first time after upgrading, clear your 
browser cache as follows, then re-enter the server URL in your browser.

For Microsoft Internet Explorer:

Step 1 Select Tools> Internet Options. 

The Internet Options dialog box opens.

Step 2 Select the General tab.

Step 3 Click Delete Files, then click OK in the Delete Files dialog box.

For Netscape Navigator:

Step 1 Select Edit>Preferences. 

The Preferences dialog box opens.

Step 2 Select Advanced>Cache.

Step 3 Click Clear Memory Cache, then click OK in the Memory Cache dialog box.

Step 4 Click Clear Disk Cache, then click OK in the Disk Cache dialog box.
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Understanding Installation Error Messages
After verifying that the correct files are installed, check the 
/var/tmp/ciscoinstall.log file for installation errors. 

The following types of installation error messages might appear:

• Information messages, give important details.

• Warning messages, which inform you that something might be wrong with a 
particular process, but the process will complete.

• Error messages, which inform you that a particular process could not 
complete

Table A-1 shows error messages that might occur during installation and 
describes the reasons for the errors.

Table A-1 Installation Messages

Message Reason for Message User Action

Access problem with directory. The installation program cannot 
access the product directory that 
you specified.

Check the permissions on the 
directory directory. 

Bad installation root dir. You are trying to install the 
product in an unusable directory.

Install the product on a 
different directory.

Base package did not install.

Exiting.

The installation program cannot 
install a package that is required 
for the product.

Contact your technical support 
representative.

Cannot backup /etc/services, no 
change will be made.

The installation program could 
not make a copy of /etc/services 
before modifying it.

Make sure that there is enough 
space in /tmp.

Cannot become owner of file in 
directory directory.

You cannot become the owner of 
a file in the directory that you 
specified as the product root.

Check the permissions on the 
directory that you specified.

Cannot change ownership of 
library. Exiting.

The installation program could 
not write to the product root 
directory.

Check the permissions on the 
directory that you specified.
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Cannot create directory. The installation program could 
not write to the directory that you 
specified.

Check the permissions on the 
directory that you specified.

Cannot create symlink: ln -s root 
/opt/CSCOpx.

The installation program cannot 
create a link from /opt/CSCOpx 
to the product root directory that 
you specified.

Contact your technical support 
representative.

Cannot determine the CiscoWorks 
Common Services version.

The installation disk is corrupted. Contact your technical support 
representative.

Cannot determine the version of 
product.

The installation program was 
unable to determine the product 
version.

Contact your technical support 
representative.

Cannot make list of packages for 
installation.

The installation has suffered a 
major failure.

Contact your technical support 
representative.

Cannot upgrade. Upgrade failed. Contact your technical support 
representative.

Copy setupdir to $nmsroot failed. The installation program could 
not write to product root 
directory.

Check the permissions on the 
root.

Installation in progress. You are already running an 
installation on this machine.

Run only one installation 
program at a time.

Missing file file. The installation program could 
not find the file file.

Contact your technical support 
representative.

No syslog facility is available. There are no available syslog 
facilities.

Make one of the facilities 
available.

Not enough disk space: root. You have picked a product root in 
a file system with insufficient 
space to load the product.

Make at least 2 GB of disk 
space available on the partition 
on which you install the 
product.

Package verification failed: pkg 
aborting.

While attempting to load our 
packages on the machine, one of 
the packages loaded incorrectly.

Contact your technical support 
representative.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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Failing to Delete a Package During Uninstallation
If you try to remove Campus Manager but the uninstallation program fails to 
delete a package, try running the uninstallation program again. Several 
circumstances can cause a package not to uninstall successfully. Running the 
uninstallation program again will usually remove it.

Syslog is not running. The installation program was 
unable to start syslogd on this 
machine.

Restart syslogd.

The components have dependency 
errors.

The installation program suffered 
a major failure.

Contact your technical support 
representative.

User must be root. You must be logged in as root to 
install the product.

Log in as root and enter the 
correct password.

Wrong OS. This operating system is not 
Solaris or not a supported version 
of Solaris.

Make sure that you are running 
Solaris 2.7 or Solaris 2.8.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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Accessing the CiscoWorks Server
The CiscoWorks server uses port 1741 by default (1742 if SSL is enabled). This 
port is normally used by web servers. If you receive an error message informing 
you that an existing web server is already configured to run on port 1741, and the 
alternative port 1744 is used instead, verify that you entered the correct URL for 
the server:

http://server_name:1744

where server_name is the name of the machine on which CiscoWorks was 
installed and 1744 is the alternative port on which CiscoWorks is installed if port 
1741 is in use.

If you still cannot access the server, enter the following command to make sure 
your server is running:

# ping server_name

If you get a message informing you that the server is “alive,” and get a proxy error 
when you try to connect to the server, make sure the proxy is set up correctly. If 
your server is configured to use a proxy server outside the firewall, you will get 
proxy errors if you configured the proxy to ignore requests to a certain machine, 
set of machines, or domain. 

You specify a proxy server in Netscape Navigator under 
Edit>Preferences> Advanced>Proxies and in Internet Explorer under 
Tools> Internet Options >Connections> LAN Settings. 

Your proxy is set up incorrectly if: 

• You receive an error message informing you that you are using a proxy 
outside the firewall.

• The proxy server recognizes www-int as an internal server, so it does not 
proxy requests to that server.

• You set up a new internal server, www-nms, but when you make a request to 
the proxy server, it does not recognize www-nms as an internal server and 
proxies the request.

• The proxy server outside the firewall tries to request data from a server inside 
the firewall, and the request is blocked.

• You get a Connection Refused error from the proxy server.
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FAQs about IDU
Q. What is an IDU?

A. IDU (Incremental Device Update) for a CiscoWorks application is a 
downloadable package containing a collection of updated files to provide you 
with support for new devices. In addition, the package also contains fixes to 
certain known problems, as well as fixes to newly discovered problems. IDUs 
are available for download for various versions of CiscoWorks applications.

Q. Why should I install the latest IDU?

A. If you had installed IDU 2.0 on Campus Manager3.2, and then upgraded to 
Campus Manager 3.3, you will not lose any device support. This is because 
IDU 2.0 has been merged into Campus Manager 3.3. But, if you had installed 
a version of IDU later than 2.0 on Campus Manager, and then upgraded to 
Campus Manager 3.3, you will lose support for new devices, and fixes to 
known problems.

Q. Where can I download an IDU?

A. To retain support for new devices, we recommend that you download and 
install the latest IDU for Campus Manager 3.3 from

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Q. How do I know which version of IDU I have installed?

A. To check the version of IDU installed on your system, from the CiscoWorks 
desktop, select Server Configuration > About the Server > Applications 
and Versions.

The Patches Installed table displays the installed version of the applications 
in the following format:

If Patches Installed table displays IDU version installed is...

CM3_2_IDU-1.0 IDU 1.0 on Campus Manager 3.2

CM3_2_IDU-2.0 IDU 2.0 on Campus Manager 3.2

CM3_2_IDU-3.0 IDU 3.0 on Campus Manager 3.2
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Q. I have upgraded to Campus Manager 3.3. But, I have lost support for some 
devices. Why?

A. If you had installed IDU 2.0 on Campus Manager 3.2, and then upgraded to 
Campus Manager 3.3, you will not lose any device support. This is because 
IDU 2.0 has been rolled into Campus Manager 3.3 . But, if you had installed 
a version of IDU later than 2.0 on Campus Manager 3.2, and then upgraded 
to Campus Manager 3.3, you will lose support for new devices.

To retain support for the new devices, we recommend that you download and 
install the latest IDU for Campus Manager 3.3 from

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus
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Mounting and Unmounting the 
CD-ROM

This appendix describes how to mount and unmount the Campus Manager 
CD-ROM on a Solaris 2.7 or 2.8 system and provides general information only. 
For more detailed instructions, consult your Sun documentation.

You can install Campus Manager from a CD-ROM mounted on the Campus 
Manager server system or from a CD-ROM mounted on a remote Solaris system. 
After you complete the Campus Manager installation, you must unmount the 
CD-ROM drive.

This appendix contains:

• Mounting a Local CD-ROM Drive

• Mounting a Remote CD-ROM Drive

• Unmounting a Local CD-ROM Drive

• Unmounting a Remote CD-ROM Drive
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Mounting a Local CD-ROM Drive
To mount a local CD-ROM drive:

Step 1 Insert the Campus CD-ROM.

Step 2 Become the superuser by entering the command su and the root password at the 
command prompt, or log in as root. The command prompt changes to the pound 
sign (#).

If the /cdrom directory does not already exist, enter the following command to 
create it:

# mkdir /cdrom

Step 3 Mount the CD-ROM drive. 

Note The vold process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 

If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM.

Step 4 If the /cdrom/cdrom0 directory is empty because the CD-ROM was not mounted, 
or if File Manager did not open a window displaying the contents of the CD-ROM, 
verify that the vold daemon is running by entering:

# ps -e | grep vold | grep -v grep

Step 5 If vold is running, the system displays the process identification number of vold. 
If the system does not display anything, restart the daemon by entering:

# /usr/sbin/vold &

Step 6 If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the process 
identification number. If you do not know the process identification number, you 
can get it by entering:

# ps -ef | grep vold | grep -v grep
B-2
Installation and Setup Guide for Campus Manager on Solaris

78-15049-01



 

Appendix B      Mounting and Unmounting the CD-ROM
Mounting a Remote CD-ROM Drive
Step 7 Stop the vold process by entering:

# kill -15 process_ID_number

Step 8 Restart the vold process by entering:

# /usr/sbin/vold &

Step 9 If you encounter problems using the vold daemon, enter the following command 
to mount the CD-ROM:

# mount -F hsfs -r ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI ID 
number, and z is the slice of the partition on which the CD-ROM is located.

You have now mounted the CD-ROM drive. See Chapter 2, “Installing Campus 
Manager” for instructions on installation.

Mounting a Remote CD-ROM Drive
To mount a remote CD-ROM drive:

Step 1 Insert the Campus CD-ROM into the CD-ROM drive of the remote machine.

Step 2 Become the superuser on the remote machine by entering the command su and the 
root password at the command prompt, or log in as root. The command prompt 
changes to the pound sign (#).

Step 3 If the /cdrom directory does not already exist, enter:

# mkdir /cdrom

Step 4 Mount the CD-ROM drive. 

Note The vold daemon process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 

If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM. 
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Step 5 If the /cdrom/cdrom0 directory is empty because the CD-ROM was not mounted, 
or if File Manager did not open a window displaying the contents of the CD-ROM, 
verify that the vold daemon is running by entering:

# ps -e | grep vold | grep -v grep

Step 6 If vold is running, the system displays /usr/sbin/vold. If the system does not 
display anything, restart the daemon by entering:

# /usr/sbin/vold &

Step 7 If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the process 
identification number. If you do not know the process identification number, you 
can get it by entering:

# ps -ef | grep vold | grep -v grep

Step 8 Stop the vold process by entering the following command:

# kill -15 process_ID_number

Step 9 Restart the vold process by entering the following command:

# /usr/sbin/vold &

Step 10 If you encounter problems using the vold daemon, enter the following to mount 
the CD-ROM:

# mount -F hsfs -o ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI ID 
number, and z is the slice of the partition on which the CD-ROM is located.

Step 11 Use a text editor to create an /etc/dfs/dfstab file, if one does not exist. 

Step 12 Add the following line to the /etc/dfs/dfstab file:

share -F nfs -o ro /cdrom/cdrom0
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Step 13 Make sure your remote machine is enabled as an NFS server by entering:

# ps -ef | grep nfs | grep -v grep

The output of this command indicates whether the /usr/lib/nfs/nfsd and 
/usr/lib/nfs/mountd daemons are running. If they are not running, enable your 
machine as an NFS server by entering:

# /etc/init.d/nfs.server start

If your machine is enabled as an NFS server, enter one of the following:

# share

or

# shareall

Step 14 Log in to the machine on which you want to install Campus as superuser by 
entering the command su and the root password, or log in as root.

Step 15 Create a /cdrom directory, if one does not already exist, by entering:

# mkdir -p /cdrom/cm33

Step 16 To mount the CD-ROM drive, enter:

# /usr/sbin/mount -r remote_machine_name:/cdrom/cdrom0 /cdrom/cm33

You have now mounted the CD-ROM drive. See Chapter 2, “Installing Campus 
Manager” for installation instructions.
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Unmounting a Local CD-ROM Drive
To unmount a local CD-ROM drive:

Step 1 As root, enter: 

# cd
# umount /cdrom/cdrom0 

Step 2 Remove the CD-ROM and store it in a safe place.

Unmounting a Remote CD-ROM Drive
To unmount a remote CD-ROM drive:

Step 1 As root, enter the following on the local machine:

# umount /cdrom/cm33

Step 2 As root, enter the following on the remote machine:

# umount /cdrom/cdrom0

Step 3 Remove the CD-ROM and store it in a safe place.
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